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Chapter 1 • Introduction 

Description 
 

The Falcon® 315 portable data terminal runs DOS 6.22 on a 32 bit, 386-based platform. 
This unit includes an 8 x 21 backlit graphics display, an RS-232 serial port, 2MB of 
RAM, 2MB of flash memory, and a choice of standard-range or long-range integrated 
laser scanners. Its keypad offers 41 large alphanumeric keys, 10 function keys, Direct 
Western-European character support, and 2 programmable side triggers. 
 

The Falcon® 315 is powered by 3 AA alkaline batteries (supplied), a rechargeable NiCd 
battery pack, a rechargeable NiMH battery pack, a Falcon® dock, and a Falcon® battery 
charger. This terminal has an operating temperature of 14° to 122° F / -10° to 50° C, a 
storage temperature of -4° to 158° F / -20° to 70° C, and a humidity rating of 5 to 95% 
(noncondensing). Additionally, it withstands multiple 4.0' / 1.2m drops to concrete.  
 
Wireless options include a choice of 2.4 GHz spread spectrum radios, long range 
mobility, high throughput network capacity, advanced power management, seamless 
roaming, access points, antennas and cables, and network and terminal emulation 
software. More information about the features of the Falcon® 315 terminal can be found 
at www.pscnet.com. 
 

Picture 

 

 

Supported Equipment Manual    •   May, 2006    1-1

http://www.pscnet.com


Introduction 

Setup Requirements 
 
Installation of PowerNet Twin Client requires, at a minimum, the following: 
• A Pentium-class processor  
• 32 MB of RAM 
• 10 MB of free hard disk space available 
• Microsoft Windows 95, 98, ME, XP, or NT/2000 operating system 

Accessories 
 
• Single-Slot Dock, p/n: 00-980-005 

• 4-Slot Dock, p/n: 00-981-015 

• Softcase with Laser, p/n: 00-910-00 

• Holster, p/n: 00-908-00 

• Belt for Holster, p/n: 00-906-00 

• Vehicle Mount Cradle, p/n: 00-528-00 

Bios 
Version of BIOS 
The most recent version of BIOS on a Falcon® 315 terminal is from 09/13/00.  

Finding the Version of BIOS 
 

The version of BIOS will appear on a terminal screen when the terminal is rebooted.   
For rebooting instructions, see Booting the Terminal in the Quick Start section. 

 

 

 

 

 
 

  Supported Equipment Manual    •   May, 2006 1-2



  Release Notes 

Release Notes 
 

1)   A Timer value of 999 will cause the back light timer to be "Always On". 
 
2)   The following describes the methods used to enable the EBCDIC~ASCII option for 

both the Thick and Thin client. 
 

Thick Client 
 
In order to enable the EBCDIC~ASCII option for the Thick client, you will need to edit 
the beginning of the rfiles.txt file: 
#-------------------------- General ------------------------- 
[*;*;*;*] 
u_msgs.txt 
 
by adding the one or two lines below as required for the translation,   
 
#-------------------------- General ------------------------- 
[*;*;*;*] 
u_msgs.txt 
a2ehex.tb 
e2ahex.tb  
 
and save it.  

 
Note:  If the file(s) do not exist, the reload on the terminal will fail.  You can specify one 

or the other, or both, but the file(s) must exist. 
 

Then place one or both of these files in the C:\PowerNet\TwinClient\terminal directory. 
 
a2ehex.tb to translate from ASCII to EBCDIC 
e2ahex.tb to translate from EBCDIC to ASCII 
 
Then reload the programs and configuration file into the terminal. 
 
To translate from an ASCII "A" to an EBCDIC "b", this is the syntax: 
#translate from an ASCII "A" to an EBCDIC "b" 
41 82 
 
To translate from an EBCDIC "A" to an ASCII "b", this is the syntax: 
#translate from an EBCDIC "A" to an ASCII "b" 
C1 62 
 
Thin Client 
 
If you are using the Thin Client in Server mode, you will need to add the two files to the 
/home/crf directory. 
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Introduction 

Patch version A  
09-07-05 
 
This change will cause the DOS emulators to use a random source port between 2000 and 
2100 on each outbound host connection. 
 
Prior to this, they used the same source port number and this would cause problems with 
some IBM hosts and Firewalls. This would lead to long timeout periods (5-30 minutes) 
on IBM hosts and lockouts under Firewalls that looked at this as a possible denial of 
service attack. 
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Chapter 2 • Terminal Setup 

Downloading from the WEB 
The PowerNet Twin Client software package can be downloaded from the Connect web 
site at http://www.connectrf.com. Click on Partner Services and then click on Software 
Downloads. Select the file named PowerNet Twin Client for PSC. 

Running Setup from a Download File 
The downloaded file is a compressed archive. After extraction using a utility such as 
WinZip or PKWARE, folders are created on the hard disk as shown in the following 
figure. 

 

Click on the Disk1 folder to view the files as shown in the following figure. 

 

Supported Equipment Manual   •   May, 2006    2-1

http://www.connectrf.com


Terminal Setup 

Click on the Setup application and proceed to the following section entitled Installation 
for further instructions. 

Installation 
The InstallShield wizard runs and presents the following screen. 

 
Click on Next to begin the installation process.  
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  Installation 

 
To change the default Destination Location, click on Browse and select a location. Then 
click on Next.  

 
The default folder is PowerNet. This default may be changed either by selecting an 
existing program group or by typing in a new name at the prompt. Then click on Next.  
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Terminal Setup 

 
 

When the installation is complete, reboot the system to initialize the Twin Client 
software. 

a. To reboot the system immediately, click on Finish.  

b. To reboot later, click on the option to restart the computer later, and then click on 
Finish.  

Running the Manager 
The PowerNet Twin Client Manager is the utility that manages the terminal software and 
configurations. 

Select Start, Programs, PowerNet, and Twin Client Manager. The PowerNet Twin 
Client Manager screen appears as shown in the following figure. This is the 
administrator's main screen, and all functions are accessed from its menu bar, toolbar, and 
tabs. 

Menu Bar 
The menu bar provides access to the functions used to configure the terminals and 
manage their software.  
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  Quick Start 

Toolbar 
Found under the menu bar, the toolbar provides shortcuts to major features. The toolbar 
can be turned on or off by changing the Toolbar parameter found on the View menu. The 
shortcuts available from the toolbar are as follows. 
 

 Create a new terminal configuration. 

 Open an existing terminal configuration. 

 Save the current terminal configuration. 

 Download the configuration to the terminal. 

 Download software to the terminal. 

 Configure terminals automatically over the wireless network. 

 View the PowerNet Twin Client Manager version. 
 

The PowerNet Twin Client Manager is now successfully installed and ready for use. 
Quick Start provides detailed instructions for quickly configuring the terminal and 
starting a Telnet session. 

Quick Start 
Quick Start describes how to prepare the Twin Client Manager and the PSC terminal for 
a Telnet session with the host. Following an initial setup procedure, the terminal software 
and configuration are managed automatically over the wireless network. 

Configuring the Manager 
The first step is to configure the Twin Client Manager to meet site-specific requirements, 
and then prepare it for the automatic management of the terminal software and IP 
addresses. This simple procedure will require only a few minutes to complete. 

Setting the Emulation 

Click on Start, Programs, PowerNet, and Twin Client Manager. Select the Settings 
menu, as shown below. 
 

Supported Equipment Manual   •   May, 2006    2-5



Terminal Setup 

 

Click on Emulation, select the desired emulation, and click on OK. 

 

Setting the Servers 

The Servers are the Telnet host systems the terminals will access. 
 

 

To set these addresses from the Settings menu, click on Servers and then click on Add. 
Enter the name of each server, its IP address and IP port (normally 23 for Telnet servers), 
and emulation type. Then click on OK.  
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  Quick Start 

 

Repeat this step for each Telnet server the terminals are required to access. If an error is 
made in the name, IP address, IP port number, or terminal emulation type, click on the 
line that is in error and then click on the Edit button to make the corrections. Use the 
Load button if you want to load an .svr file. Use the Save As button if you want to save 
your file as an .svr file. 

Setting Terminal Operations 

In the Twin Client menu under Settings, choose Terminal Operation. 

 

Run AirLoader on terminal can be selected, and the AirLoader server IP address can be 
entered. 

 

Click on OK when finished. 
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Terminal Setup 

Setting Terminal Model  

Under Settings, choose the Options menu as shown. 
 

 

Select terminal model, desired radio type, and COM port. 
 

 

Saving the Configuration 

Click on File and Save As. Enter a name for this configuration.  
 

 

For the purposes of this example, the name is vt100. 
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  Quick Start 

 

Setting Airloader Auto-Configuration 

The configuration download and IP address assignment for each terminal will take place 
automatically by setting the Airloader Auto-Configuration options. 
 

 

Click on the Airloader option in the Tools menu. 

Note: If the Airloader Auto-Configuration window does not display the options, click on 
the Advanced<< button. 

If multiple network adapters are installed on the PC, ensure that the desired network 
adapter is selected. The adapter selection can be changed by clicking on the Change 
button.  
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Terminal Setup 

 

This powerful software management tool is described in detail in Airloader Auto-
Configuration. For now, it is sufficient simply to use it for assignment of the initial 
terminal configuration and IP address, both of which can be easily changed later. Ensure 
that all of the check boxes are checked as shown above. 

To assign terminal IP addresses automatically over the wireless network, check all of the 
boxes as shown above. Then click on the Addresses button and enter the desired range 
in the From and To boxes as shown in the following figure. 

 

After setting the address range, click on OK to return to the Airloader Auto-Configuration 
screen. 
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  Quick Start 

 
 

Click on the + sign in front of Terminal/Group Manager to access the default terminal 
group. Next, click on the New Group icon and use the Browse button to select the 
configuration file saved earlier. 
 

 

Check the Active box, and the system is now configured to automatically download IP 
addresses, software, and configuration files to the terminals. Click on the  box in the 
upper right corner to return to the main menu. 

Note: The software does not need to be authorized now. It can be authorized later, after a 
Telnet session has been established. The procedure is described in Authorizing 
PowerNet. 

Downloading Files To Terminal 
Twin Client program and configuration files are installed on the terminal with the 
following procedure. Boot the terminal according to the instructions in the next section. 
At the DOS prompt, type “LD” but do not Enter at this time. 

Under the Terminal menu, click on the Send Program Files to Terminal menu option. 
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Terminal Setup 

 

At the prompt, choose Yes or No to download configurations. Choosing Yes is needed to 
run in Telnet mode. 

 

The following screen will appear. 

 

Now, choose Enter on the terminal, while choosing OK at the prompt above. 

The files will transfer at this time. Watch the terminal to see that the correct files are 
loading.  Boot the terminal according to the following section.  The Twin Client Manager 
will then automatically manage the terminal software and configuration.  

Booting the Terminal 
At any time it is necessary to update the terminal software and/or configuration, the 
terminal must be booted. To cold boot the terminal, turn the unit Off, then press 
<Alt>+<FN2>+<Power>. Release all three keys simultaneously. 

A warm boot is performed by pressing <Ctrl>+<Alt>+<Del>. 
 

A successful wireless connection is indicated by the display of the Twin Client main 
menu shown below. 
 

Twin Client 
© 1991-2006, Connect, Inc. 
 
Keypress to Continue  

The date of 2006 is updated on the terminal at the time of a new release. 

The terminal is now ready to establish a Telnet session with the host system. 
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  Quick Start 

Starting a Telnet Session 
At the Twin Client main menu on the terminal, press any key to establish the connection. 
Until the terminal has been authorized, the following screen is displayed. 
 

RECOVERABLE ERROR 
Terminal not 
Authorized for 
Twin Client  
 
Keypress to Continue 

It is not necessary to authorize the terminal at this time, so press any key to continue. The 
terminal will establish a connection with the host system and start emulation. If the 
terminal fails to connect to the host, refer to the following tables. 
 

Failure Cause Corrective Action 
Incorrect Host IP address Correct the Host List address on the terminal. Refer to 

Terminal Setup Using Twin Client Menus. 
Incorrect netmask value Access the Edit Functions menu.  Correct the netmask 

value. Refer to Terminal Setup Using Twin Client Menus. 

 
Error Indication Possible Cause Corrective Action 
NOT Associated Invalid NETID Run current radio setup program and 

set NETID to match the access point. 
See Terminal Setup Using Twin Client 
Menus. 

No AirLoad 
Manager Found. 

AirLoad Manager not 
active, or not installed 
on the LAN segment. 

Ensure that the PC with Twin Client 
Manager is on the same segment and 
that the PC is operating. If the PC is 
not on the same segment, enter the 
address of the PC in response to the 
terminal prompt. 

Manager not Active Previously identified 
AirLoad Manager is no 
longer found. 

Same as above 

Unable to open 
connection 

IP stack on terminal 
failed to load. 

Reload Program Files and reboot. 

Timeout waiting for 
data 

Transient 
communications 
failure 

Reboot terminal. If problem persists, 
check the RFSYNC.log in the 
PowerNetTN directory. 

Download aborted Socket closed during 
download 

Ensure that PC is operating. Reboot 
terminal and retry. 

Manager inactive PC not operating Restart the Airload PC server. 
 

After a Telnet session has been successfully established, the terminal will remain in 
session for a maximum of 30 minutes at a time until it has been authorized. Once 
authorized, there is no software restriction on the session time. The instructions for 
authorizing the terminal are presented in Authorizing PowerNet. 
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Terminal Setup 

Standard Setup 
The default terminal setup is sufficient for most installations. However, to meet site-
specific requirements, it may be necessary to customize terminal operation. The standard 
setup options simplify this process and can be modified by the following methods: 
• Using the Twin Client Manager. 
• Using the Twin Client terminal menu system. 

Standard Setup describes how to use the Twin Client Manager and the terminal menu 
systems to set up the terminal. Also described are the methods for authorizing the 
terminal software. 

Setup Using Twin Client Manager 
The Twin Client Manager provides a Standard Settings tab for the automatic setup of 
terminals. Choose Standard from under the View menu. The options within this tab vary 
according to the emulation selected, each of which is described below. 

VT Settings 

Select the VT emulation setup by clicking on the Settings menu and then the Emulation 
menu, as shown below.  
 

 

Then click on the vt100 or vt220 selection, as shown below.  

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for VT emulation. 

  Supported Equipment Manual    •   May, 2006 2-14



  Standard Setup 

 
 
Quadrant Mode 

The scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display.  As defined by Twin Client, quadrants are fixed position 
“windows” in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   

Font 
 

These check boxes enable (checked) or disable (unchecked) the display of characters in 
double high and double wide font. 
 
Key Click 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal. The default value is on (checked). 
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Terminal Setup 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 
 

5250 Settings 

Select the 5250 emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below.  
 

 

Then click on the 5250 selection, as shown below.  
 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 5250 emulation. 
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  Standard Setup 

 
 
Quadrant Mode 

The scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display.  As defined by Twin Client, quadrants are fixed position 
“windows” in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   

Font 
 

These check boxes enable (checked) or disable (unchecked) the display of characters in 
double high and double wide font. 
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Terminal Setup 

Key Click 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal. The default value is on (checked). 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 
 

3270 Settings 

Select the 3270 emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below.  
 

 

Then click on the 3270 selection, as shown below.  
 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 3270 emulation. 
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  Standard Setup 

 
 
Quadrant Mode 

The scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display.  As defined by Twin Client, quadrants are fixed position 
“windows” in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   

Font 
 

These check boxes enable (checked) or disable (unchecked) the display of characters in 
double high and double wide font. 
 
Key Click 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal. The default value is on (checked). 

Supported Equipment Manual   •   May, 2006    2-19



Terminal Setup 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 
 

Terminal Setup Using Twin Client Menus 
For compatibility with other PowerNet products, the PowerNet Twin Client for PSC also 
supports the standard Twin Client configuration menu system on the terminal. This menu 
system is accessed by pressing uppercase C at the Twin Client main menu below. 
 

Twin Client 
© 1991-2006, Connect, Inc. 
 
Keypress to Continue  

The following menu appears. 
 

Edit Network 
Edit Mobile Unit IP  
Edit Server/Host IPs 
Edit License Key 
Run Site Survey 
Switch Client Modes 
Run Client Emulator 
Exit to OS 

Use the Up-Arrow and Down-Arrow keys to navigate the menu, and press Enter to select 
the highlighted option. Each menu option is described below. 

Edit Mobile Unit IP  

The IP list contains the terminal IP address, the Subnet Mask and the Router IP address. 
Enter the appropriate address. Select F3 to save and/or F7 to Quit, as shown below. 
 

IP  206.232.71.38 
SN  255.255.255.0 
RT  206.232.71.1 
 
<F3> Save  <F7> Quit 

Edit Server/Host IPs  

If the host IP address(es) were not pre-configured as described in the Setting the Servers 
section of Configuring the Manager, or if you wish to change those settings using the 
terminal menus, select this option and enter up to four Host IP addresses as required. 
 

     Host 0 
IP 206.183.67.155 
Port 23__ 
 
<F3> Save <F7> Quit 
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  Standard Setup 

Press F3 to save the configurations. 

Edit License Key 

The client software can be authorized automatically, as described in the next section, 
Authorizing PowerNet. This menu option permits authorization of each terminal 
manually. Select this option to obtain the terminal's Identification Code, which is used to 
obtain the Authorization code from the Connect web site, as described in the next section. 

The 12-digits displayed at the terminal screen top is the terminal’s Identification Code. 
 

00A0F826E614 
Authorization 
    ______________ 
not authorized 
 
<F3> Save <F7> Quit 

Type the Authorization code into the field as it appears on the web site. Uppercase letters 
are significant, and punctuation characters, such as the hyphen (-), are required. Press F3 
to save the Authorization code. 

Run Site Survey 

This option (a feature of Spectrum 1) is applicable to Release 5.0 and may be obsolete for 
your terminal. 

Switch Client Modes 

The PowerNet Twin Client normally operates in Telnet mode, which provides direct 
connection to Telnet hosts. It can also operate in Server mode, through a PowerNet 
OpenAir server. Select this menu option to switch between Server and Telnet modes of 
operation. Note that the host socket address for the PowerNet OpenAir servers is 1800, 
which must also be changed in the Edit Server/Host IPs menu described above. 

Run Client Emulator 

After all desired changes have been made, select this option to return to the Twin Client 
main menu. Then press any key to establish the Telnet session and begin emulation. 
Refer to Starting a Telnet Session for further instructions. 
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Terminal Setup 

Authorizing PowerNet 
 
Each PowerNet Twin Client will run for 30 minutes at a time without authorization.  
Uninterrupted operation for a production environment is the result of authorizing the 
software.  

The Twin Client Manager can automatically authorize the terminal over the wireless 
network if the following requirements are met: 
• A PC running Twin Client Manager is connected to the wire LAN segment with at 

least one access point within range of the terminal. 
• The System ID of the PC on which Twin Client Manager is installed has been used to 

obtain a site license Authorization code from the Connect web site. 

To obtain the Twin Client Manager’s System ID, click on Authorization under Tools. 
 

 

The Authorization window is displayed as shown below. 
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  Standard Setup 

Go to http://www.connectrf.com. Click on Partner Services. Click on the Generate 
Authorization icon at the top of the page. Follow the directions on the web site. 

Authorized Terminals 

The number of terminals authorized, the number of terminals in use, and the number of 
terminals remaining is provided in the Authorized Terminals box on the lower left side of 
the screen. 

Click on the Details button to number the options in the screen below in the order of your 
priority. 
 
Note: The terminal may or may not be able to utilize the Formatter feature depending on 

its Authorization codes. 
 

 
 

Click on an option and move it using the Up and Down buttons.  

Click on OK when finished. 

The Manual Authorization button is an alternate method of obtaining an Authorization 
code for a terminal. This method does not utilize Airloader, as does the other method. 
Click on this button, manually enter your MAC address in the screen that appears, and 
click on OK. This enables you to generate individual Authorization codes. 
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Terminal Setup 

Adding Licenses 

The Add Licenses feature is used when adding additional licenses to an already site 
licensed Twin Client Manager.  (i.e. Twin Client Manager is licensed for 10, and the 
customer purchases another 10 licenses to make a total of 20.)   

From Twin Client Manager, choose Authorization from under the Tools menu. Click on 
the Add Licenses button.  

 

 

A pop-up box appears with the Machine ID and a space for the additional license’s 
Authorization code.  Enter the additional license’s Authorization code and click on OK. 

Use the Machine ID in the pop-up box instead of the original Machine ID to get your 
Authorization code.   
 
If adding users, click on the Add Licenses button before generating the Authorization 
code to get the most current Machine ID. 
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  Standard Setup 

Transferring Licenses 
 

The Transfer Licenses feature is used when moving a site license from one PC to 
another.  After Twin Client Manager is installed on a new PC, you will need the 
System/Machine ID for it.   
 
From Twin Client Manager, select Authorization from under the Tools menu. 
 
Click on the Transfer Authorization button on the old PC. You will be asked for the 
new System ID.  Enter this new System ID.  It will generate an Authorization code for 
the new PC's Twin Client Manager.  
 

 
 

Note: This feature only works if there are licenses remaining on the old PC.  
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Terminal Setup 

Listing 
 
Click on the Listing button to view Authorization codes used along with corresponding 
serial numbers. The Authorization codes used along with their corresponding serial 
numbers will appear. 

 

 
 

Click on OK when finished. 

Click on the Close button when finished. 
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  Software Management 

Software Management 
In addition to providing functions for the download of files to the terminal, the Twin 
Client Manager also provides for the management of terminal software and 
configurations automatically over the wireless network. 

Software Management describes the automated capability in detail. Additional manual 
operations involving serial download options are described at the end of it. 

Airloader Auto-Configuration 
The Airloader Auto-Configuration form is accessed from the Twin Client Manager Tools 
menu. Select Airloader.  

 
Note: If no options are displayed, click the Advanced<< button. 

Enabling Automatic Downloads 

Click to put a check in the box that allows terminals to be automatically configured via 
RF to enable automatic downloading. In the event that another PC on the network is 
already configured and active, the following warning message is displayed. 
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Synchronizing Configuration Files 

Click to put a check in the Synchronize Configuration Files box to enable automatic 
synchronization of configuration files on the terminal. When the terminal is booted, its 
configuration files will be compared with the most recent on the PC. The terminal is 
updated automatically if it does not have the latest revision. 

Synchronizing Program Files 

Click to put a check in the Synchronize Program Files box to enable automatic 
synchronization of program files on the terminal. When the terminal is booted, its 
program files will be compared with the most recent on the PC. The terminal is updated 
automatically if it does not have the latest revision. 

Automatic IP Address Assignment 

New terminals will be assigned IP addresses automatically if the following box is 
checked. 

 
 

Note: Do not check this option if a DHCP server is configured to manage address 
assignments. 

To set the addresses, click on the Addresses button to access the Segment Address 
Assignments dialog box, as shown in the following figure. 
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Enter the desired range in the From and To boxes as shown above, and then click on 
Add. 

Creating New Groups 

New groups, with different configurations, can be created by clicking on 
Terminal/Group Manager, and then clicking the right mouse button as shown. 

 

After the new group has been created, the group settings option becomes available for 
change, as shown below. 
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After the Configuration File and all of the other parameters have been set, the group is 
made active by clicking on the Active check box. 
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Clicking on the Thin Mode button will cause all terminals in this group that are 
currently running in thick mode to be switched to thin mode the next time Airloader 
is run on the terminal. 

Click on the Schedule button to view a dialog box for scheduling an automatic Airloader 
update. 

 

Select the desired time and click on OK. Click on Update Now and the Airloader “push” 
capability controls terminals from this end. 
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Setting the Segment 

Checking the Segment button restricts a terminal group to a range of IP addresses. The 
IP Address can be any valid address on the segment, as it is used only to identify the 
segment. The setting of the Net Mask can be used to restrict the range.  This feature is 
useful for segregating terminal groups by location. 

Setting Force Reload 

Clicking on the Force Reload button forces all terminals within a group to be 
automatically updated. The following warning message appears. 

 

Click on the Yes button to force the reload. 

Setting the Default Terminal Group 

New terminals that have not yet been assigned to any group are initially assigned to the 
default group in effect when they are booted. 

 

Any group can be made the default group by clicking on the group, and then clicking on 
the right mouse button. Then click on the Make Default option. 

Reassigning Terminals 

After a terminal has been configured and assigned to the default group, it can be 
reassigned to a new group by clicking on the terminal icon as shown below. 
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Then, holding the mouse button down, drag the terminal icon to the desired group as 
shown next. 

 

Release the mouse button, which reassigns the terminal. 

 

The next time the terminal is rebooted, it will be reconfigured as defined in the group 
specification. 

Mobile Device Manager (MDM) Features 
 
Under Tools in Twin Client Manager are the Screen Watcher, Terminal Messenger, and 
RF Monitor features. 

Note: The terminal may or may not be able to utilize the Screen Watcher or Terminal 
Messenger features depending on its Authorization codes. 

 
 
Select Screen Watcher, enter the terminal’s IP address, and click on OK. 
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A screen will appear with a display resembling the terminal screen. 
 

 

Clicking on the Font button on the upper left brings up a screen in which you can modify 
the font settings, as shown below. 

 
 
Select Terminal Messenger from the Tools menu.  
 
You may enter an Address Range in the From and To boxes on this screen. Click on Add 
when finished. 
 
Enter a message to send in the space provided, select the terminal to receive this message 
by clicking on it in the Select Terminal(s) column, and click on the Send button to send 
the message of your choice to the terminal of your choice. 

See the example of the Terminal Messenger screen below. 
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To remove a terminal from the list of terminals receiving your message, click on the 
terminal number in the Select Terminal(s) column, and click on the Remove button. 
Click on the appropriate button, Remove All, Select All, or Unselect All, to remove all 
terminals, select all terminals, or unselect all terminals from the Select Terminal(s) list. 

Note: Use the Ctrl and Shift keys to select multiple terminals. 
 
Click on the Close button when finished. 
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Select RF Monitor from the Tools menu. 
 

 
 

RF Monitor is an "Over The Air" diagnostic tool. It is used to collect diagnostic trace 
information from RF terminals running PowerNet Twin Client software. 
 
It runs on a Windows PC and will send a command to the RF terminal to start tracing. 
The terminal, when it receives this command, will start sending the trace information 
over the RF link to the PC that issued the command. This will be written to a file on this 
PC that can be sent to us for analysis. 
 
Click on File to Select Terminal or to Exit. 

 

Choosing Select Terminal allows you to view a log of the terminal’s activity. Enter the 
Terminal IP Address and Terminal IP Port, and click on OK.  
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Click on Edit. Select Find and/or Find Next to search for pieces of information in your 
log, or select Clear to clear the search. 

 

Click on Actions to select Start Monitor or Stop Monitor. 

 

Click on Tools to choose Set Debug Levels or Settings. 

 

 
The options in Set Debug Levels are shown below. 
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The maximum log file size can be set under Settings. 

 

 
Click on View to show or hide the Toolbar and the Status Bar. 

 

This is the Toolbar. It is found near the top of the screen. 

 

This is the Status Bar. It is found at the bottom of the screen. 

 

Click on About RF Monitor under Help to view version number information. Click on  
About Twin Client Manager under Help in the main menu to view the following screen. 
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RF Monitor is a very small program and does not even require installation. Just place it in 
a directory on your PC and create a shortcut to run it. It will run on all versions of 
Windows except V3.1 and Windows 95.  

 
1. Move RF Monitor to a Windows PC with Network access to the RF terminal. 

 
2. Run RF Monitor. (Create a shortcut or do a Start/Run.) 

 
3. From the pull down menu, select File/Select Terminal. 

 
4. Key in the RF terminal IP address and leave the port at 1802. 

 

 
 
5. From the pull down menu, select Tools/Set Debug Levels. Set all levels to 9 except 

Datastream and SNA. 
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6. With the RF terminal sitting at the Press Any Key prompt, select Actions/Start 
Monitor. 
 

7. Press a key on the RF terminal to open a session, and you should see trace data in the 
RF Monitor window. When done, end the trace and the file will be named 
tnxxx.yyy.log (where xxx.yyy is the last 2 octets of the RF terminal’s IP address) in 
the directory in which RF Monitor was running. 
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Common Problems with RF Monitor 
 

• The trace won’t start.  

RF Monitor uses UDP to send commands to the RF device. On busy networks, UDP 
packets are not always delivered. The terminal can miss the command to start the 
trace. Below are some things that can be useful. 
 
a.   Ping the RF terminal from the PC used before starting RF Monitor. (This seems 

to "open" a path to the terminal.) 

b.   Start the Monitor with the terminal at the Press Any Key prompt. (While the 
terminal is at this prompt, it is not doing much and has a better chance of hearing 
the start trace command.) 

 
• I don't understand what this trace means. 

 
The trace that this tool collects is engineering-level information. It allows an end user 
to collect information that can be analyzed by Connect engineering. 
 
It will generally be requested by Connect support to help diagnose a reported 
problem. 
 
To be able to read and understand these completely, you need to have an 
understanding of: 
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a. Emulation protocols (IBM 5250, IBM 3270, DEC VT200, etc.) 
b. PowerNet Twin Client products 
c. RF network concepts 
d. Wired network concepts 
e. Telnet sessions 
f.  TCP/IP  

They are text files that can be read with any editor or viewer and can be useful to end 
users and integrators, even if they may not have all the requirements above. 

 
• I have an intermittent problem and it could happen on any one of my 100 

terminals. RF Monitor only does one terminal at a time. What can I do? 
 
RF Monitor is not the right diagnostic tool for this type of problem. PowerNet 
products have another diagnostic tool that can be used called the "Diagnostic Server".  
 
This tool can be set up to run trace diagnostics on up to 300 terminals at the same 
time. This tool will be provided as needed for systems under PowerNet support 
agreement OR by T&M when they are not covered. 
 
It also includes the service of a PowerNet support engineer. 
 

Server Transfer is another feature. From the Tools menu, select Server Transfer. 

 
The FTP Settings screen appears. 

 
x 
To send object editor and configuration files from Windows to your Linux box, enter 
your server address, and click on OK. 
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Manual Download of Configuration Files 
The automated configuration management provided by the Twin Client Manager 
eliminates the need for manual terminal configuration. However, this function can be 
accomplished manually by clicking on Terminals and Send Configuration Files to 
Terminal. On the terminal, type “LD” at the DOS prompt, but do not Enter at this time. 

Note: This procedure assumes that the PowerNet Twin Client was previously installed. 

 

The following screen appears. 

 

Choose Enter on the terminal while choosing OK at the prompt above. Boot the terminal. 
The terminal is now ready to begin a Telnet session with the new configuration files. 
 
Under Terminal, you may select Receive File from Terminal. 
 

 
 
Enter the path and file name to receive from the terminal in the Upload File dialog box. 
 

 
 
The default file is “rf.log”. Click on OK. 
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Chapter 3 • Keypad Configuration 

Keypad Figures 
(The keypad figures for the Falcon® 315 terminal begin on the following page.)
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Keypad Table  

 
Key VTERM 3270 5250 
a <Alpha><▲> <Alpha><▲> <Alpha><▲> 
b <Alpha><▼> <Alpha><▼> <Alpha><▼> 
c <Alpha><◄> <Alpha><◄> <Alpha><◄> 
d <Alpha><►> <Alpha><►> <Alpha><►> 
e <Alpha><7> <Alpha><7> <Alpha><7> 
f <Alpha><8> <Alpha><8> <Alpha><8> 
g <Alpha><9> <Alpha><9> <Alpha><9> 
h <Alpha><4> <Alpha><4> <Alpha><4> 
i <Alpha><5> <Alpha><5> <Alpha><5> 
j <Alpha><6> <Alpha><6> <Alpha><6> 
k <Alpha><1> <Alpha><1> <Alpha><1> 
l <Alpha><2> <Alpha><2> <Alpha><2> 
m <Alpha><3> <Alpha><3> <Alpha><3> 
n <Alpha><-> <Alpha><-> <Alpha><-> 
o <Alpha><0> <Alpha><0> <Alpha><0> 
p <Alpha><.> <Alpha><.> <Alpha><.> 
q <Alpha><+> <Alpha><+> <Alpha><+> 
r <Alpha><=> <Alpha><=> <Alpha><=> 
s <Alpha><#> <Alpha><#> <Alpha><#> 
t <Alpha><$> <Alpha><$> <Alpha><$> 
u <Alpha><,> <Alpha><,> <Alpha><,> 
v <Alpha><%> <Alpha><%> <Alpha><%> 
w <Alpha><:> <Alpha><:> <Alpha><:> 
x <Alpha><\> <Alpha><\> <Alpha><\> 
y <Alpha><*> <Alpha><*> <Alpha><*> 
z <Alpha><?> <Alpha><?> <Alpha><?> 
A <Caps><Alpha><▲> <Caps><Alpha><▲> <Caps><Alpha><▲> 
B <Caps><Alpha><▼> <Caps><Alpha><▼> <Caps><Alpha><▼> 
C <Caps><Alpha><◄> <Caps><Alpha><◄> <Caps><Alpha><◄> 
D <Caps><Alpha><►> <Caps><Alpha><►> <Caps><Alpha><►> 
E <Caps><Alpha><7> <Caps><Alpha><7> <Caps><Alpha><7> 
F <Caps><Alpha><8> <Caps><Alpha><8> <Caps><Alpha><8> 
G <Caps><Alpha><9> <Caps><Alpha><9> <Caps><Alpha><9> 
H <Caps><Alpha><4> <Caps><Alpha><4> <Caps><Alpha><4> 
 I <Caps><Alpha><5> <Caps><Alpha><5> <Caps><Alpha><5> 
J <Caps><Alpha><6> <Caps><Alpha><6> <Caps><Alpha><6> 
K <Caps><Alpha><1> <Caps><Alpha><1> <Caps><Alpha><1> 
L <Caps><Alpha><2> <Caps><Alpha><2> <Caps><Alpha><2> 
M <Caps><Alpha><3> <Caps><Alpha><3> <Caps><Alpha><3> 
N <Caps><Alpha><-> <Caps><Alpha><-> <Caps><Alpha><-> 
O <Caps><Alpha><0> <Caps><Alpha><0> <Caps><Alpha><0> 
P <Caps><Alpha><.> <Caps><Alpha><.> <Caps><Alpha><.> 
Q <Caps><Alpha><+> <Caps><Alpha><+> <Caps><Alpha><+> 
R <Caps>Alpha><=> <Caps>Alpha><=> <Caps>Alpha><=> 
S <Caps><Alpha><#> <Caps><Alpha><#> <Caps><Alpha><#> 
T <Caps><Alpha><$> <Caps><Alpha><$> <Caps><Alpha><$> 
U <Caps><Alpha><,> <Caps><Alpha><,> <Caps><Alpha><,> 
V <Caps><Alpha><%> <Caps><Alpha><%> <Caps><Alpha><%> 
W <Caps><Alpha><:> <Caps><Alpha><:> <Caps><Alpha><:> 
X <Caps><Alpha><\> <Caps><Alpha><\> <Caps><Alpha><\> 
Y <Caps><Alpha><*> <Caps><Alpha><*> <Caps><Alpha><*> 
Z <Caps><Alpha><?> <Caps><Alpha><?> <Caps><Alpha><?> 
Alpha <Alpha> <Alpha> <Alpha> 
Fn1 <Fn1> <Fn1> <Fn1> 
Fn2 <Fn2> <Fn2> <Fn2> 
Tab <Tab>  <Tab>  <Tab>  
Esc <Esc> <Esc> <Esc> 
Space <Space> <Space> <Space> 
Caps Lock <Caps> <Caps> <Caps> 
Ctl <Ctl> <Ctl> <Ctl> 
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Alt <Alt> <Alt> <Alt> 
Intl   <Intl>     <Intl>    <Intl> 
Bksp  <Bksp>  <Bksp>  <Bksp>  
Enter <Enter> <Enter> <Enter> 
Del <Del> <Del> <Del> 
1 <1> <1> <1> 
2 <2> <2> <2> 
3 <3> <3> <3> 
4 <4> <4> <4> 
5 <5> <5> <5> 
6 <6> <6> <6> 
7 <7> <7> <7> 
8 <8> <8> <8> 
9 <9> <9> <9> 
0 <0> <0> <0> 
!                    exclamation <Fn1><:> <Fn1><:> <Fn1><:> 
@                           at sign <Fn1><=> <Fn1><=> <Fn1><=> 
#                             pound <#> <#> <#> 
$                              dollar <$> <$> <$> 
%                          percent <%> <%> <%> 
^                               carat <Fn2><?> <Fn2><?> <Fn2><?> 
&                    ampersand <Fn2><=> <Fn2><=> <Fn2><=> 
*                          asterisk <*> <*> <*> 
(              left parenthesis <Fn1><+> <Fn1><+> <Fn1><+> 
)           right parenthesis <Fn1><%> <Fn1><%> <Fn1><%> 
F1 <Fn1><1> <Fn1><1> <Fn1><1> 
F2 <Fn1><2> <Fn1><2> <Fn1><2> 
F3 <Fn1><3> <Fn1><3> <Fn1><3> 
F4 <Fn1><4> <Fn1><4> <Fn1><4> 
F5 <Fn1><5> <Fn1><5> <Fn1><5> 
F6 <Fn1><6> <Fn1><6> <Fn1><6> 
F7 <Fn1><7> <Fn1><7> <Fn1><7> 
F8 <Fn1><8> <Fn1><8> <Fn1><8> 
F9 <Fn1><9> <Fn1><9> <Fn1><9> 
F10 <Fn1><0> <Fn1><0> <Fn1><0> 
F11 <Alt><1> <Alt><1> <Alt><1> 
F12 <Alt><2> <Alt><2> <Alt><2> 
F13 <Alt><3> <Alt><3> <Alt><3> 
F14 <Alt><4> <Alt><4> <Alt><4> 
F15 <Alt><5> <Alt><5> <Alt><5> 
F16 <Alt><6> <Alt><6> <Alt><6> 
F17 <Alt><7> <Alt><7> <Alt><7> 
F18 <Alt><8> <Alt><8> <Alt><8> 
F19 <Alt><9> <Alt><9> <Alt><9> 
F20 <Alt><0> <Alt><0> <Alt><0> 
F21 --- <Alt><▲> <Alt><▲> 
F22 --- <Alt><▼> <Alt><▼> 
F23 --- <Alt><◄> <Alt><◄> 
F24 --- <Alt><►> <Alt><►> 
▲ <▲> <▲> <▲> 
◄ <◄> <◄> <◄> 
▼ <▼> <▼> <▼> 
► <►> <►> <►> 
/                  forward slash <Fn2><\> <Fn2><\> <Fn2><\> 
`                              accent <Fn1><\> <Fn1><\> <Fn1><\> 
-                            hyphen <Fn2><,> <Fn2><,> <Fn2><,> 
=                      equal sign <=> <=> <=> 
[                      left bracket <Fn2><$> <Fn2><$> <Fn2><$> 
]                   right bracket <Fn2><*> <Fn2><*> <Fn2><*> 
\              backward slash <\> <\> <\> 
;                       semicolon <Fn2><:> <Fn2><:> <Fn2><:> 
‘                      apostrophe <Fn2><+> <Fn2><+> <Fn2><+> 
,                             comma <,> <,> <,> 
.                              period <.> <.> <.> 
~                                 tilde <Fn2><#> <Fn2><#> <Fn2><#> 
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_                     underscore <Fn2><,> <Fn2><,> <Fn2><,> 
+                  addition sign <+> <+> <+> 
{                         left brace <Fn1><$> <Fn1><$> <Fn1><$> 
}                      right brace <Fn1><*> <Fn1><*> <Fn1><*> 
|         broken vertical bar <Fn1><#> <Fn1><#> <Fn1><#> 
:                               colon <:> <:> <:> 
“              quotation mark <Fn2><%> <Fn2><%> <Fn2><%> 
<                less-than sign <Fn1><,> <Fn1><,> <Fn1><,> 
>          greater-than sign <Fn1><?> <Fn1><?> <Fn1><?> 
?               question mark <?> <?> <?> 
Insert <Fn2><Del> <Fn2><Del> <Fn2><Del> 
Home <Fn2><◄> <Fn2><◄> <Fn2><◄> 
End <Fn2><►> <Fn2><►> <Fn2><►> 
Page Up <Fn2><▲> <Fn2><▲> <Fn2><▲> 
Page Down <Fn2><▼> <Fn2><▼> <Fn2><▼> 
Numovr --- <Alt><Alpha><0> <Alt><Alpha><0> 
Roll up --- --- <Alt><Alpha><9> 
Roll down  --- --- <Alt><Alpha><3> 
View up <Ctrl><▲> <Ctrl><▲> <Ctrl><▲> 
View down <Ctrl><▼> <Ctrl><▼> <Ctrl><▼> 
View left <Ctrl><◄> <Ctrl><◄> <Ctrl><◄> 
View right <Ctrl><►> <Ctrl><►> <Ctrl><►> 
Light <Fn2><.> <Fn2><.> <Fn2><.> 
Dark <Fn2><-> <Fn2><-> <Fn2><-> 
Swap <Fn2><Intl> <Fn2><Intl> <Fn2><Intl> 
PA1 --- <Fn><1> --- 
PA2 --- <Fn><2> --- 
PA3 --- <Fn><3> --- 
Attention --- <Alt><Esc> <Alt><Esc> 
Bottom --- <Fn2><▼> <Fn2><▼> 
Clear --- <Alt><Del> <Alt><Del> 
Redraw --- <Alt><Alpha><:> <Alt><Alpha><:> 
Field exit --- --- <Alt><Enter> 
FM --- <Alt><Alpha><8> <Alt><Alpha><8> 
Help --- <Alt><Alpha><?> <Alt><Alpha><?> 
EOF --- <Alt><Enter> --- 
Field - --- --- <Alt><Alpha><-> 
New line --- <Alt><Alpha><2> <Alt><Alpha><2> 
Field + --- --- <Alt><Alpha><+> 
Reset --- <Alt><-> <Alt><-> 
Sys req --- <Alt><.> <Alt><.> 
Top --- <Fn2><▲> <Fn2><▲> 
Dup --- <Alt><Alpha><,> <Alt><Alpha><,> 
Refresh --- <Alt><Alpha><=> <Alt><Alpha><=> 
Null end --- <Alt><Alpha><7> <Alt><Alpha><7> 
Back tab <Alt><Tab> <Alt><Tab> <Alt><Tab> 
Devcncl --- <Alt><Alpha><\> <Alt><Alpha><\> 
Stat <Alt><Alpha><$> <Alt><Alpha><$> <Alt><Alpha><$> 
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Chapter 4 • Error Message Resolution Guide 
Twin Client Error Message Resolution Guide 

 
Message Reason Solution Reference Tech Note 

ENTRY TOO LONG; Trying to key beyond the field size. Ensure that you are entering input into the 
correct field. 

--- 

ALPHABETIC ONLY; Trying to key a character that is not 
alphabetic. 

Ensure that you are entering input into the 
correct field. 

--- 

MINUS NOT VALID; Trying to key a Minus sign. Ensure that you are entering input into the 
correct field. 

--- 

DECIMAL NOT VALID; Trying to key a Decimal (period). Ensure that you are entering input into the 
correct field. 

--- 

ALPHANUMERIC ONLY; Trying to key characters other than 
Alphabetic and numeric. 

Ensure that you are entering input into the 
correct field. 

--- 

NUMERIC ONLY; Trying to key characters other than 
numeric. 

Ensure that you are entering input into the 
correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into the 
correct field. 

--- 
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INVALID KEY; The key pressed is not valid. Ensure that you are entering input into the 
correct field. 

--- 

MUST CLEAR FIELD; Trying to enter data in a field that 
must be cleared first. 

Ensure that you are entering input into the 
correct field. 

--- 

SCAN NOT ALLOWED; Trying to scan into a key only field. Ensure that you are entering input into the 
correct field. 

--- 

KEY NOT ALLOWED; Trying to key into a scan only field. Ensure that you are entering input into the 
correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into the 
correct field. 

--- 

RECOVERABLE ERROR; Encountered an error from which 
you can continue. 

Verify that your configuration settings for 
the hardware being used, usually a printer 
and cable issue. 

--- 

UNRECOVERABLE ERROR; Encountered an error from which 
you can NOT continue. 

Verify that your Network settings are 
correct and you are in the correct mode 
using the correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

FUNCTION: \n\nFILE: \nLINE: \nCODE; Encountered an error from which 
you can NOT continue. 

Notify Connect over the WEB incident 
reporting system. 

--- 

Press any key\nFor More Details...; Press Enter for more information. Advisory message. --- 

Press any key; Press a key to continue. Advisory message. --- 
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Connection ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Connect. Verify that your Network settings are 
correct and you are in the correct mode 
using the correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Disconnect ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Disconnect. Verify that your Network settings are 
correct and you are in the correct mode 
using the correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Send ERROR.\nREBOOT MOBILE 
UNIT; 

Could not Send. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Receive ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Receive. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Check ERROR.\nREBOOT 
MOBILE UNIT; 

Could not run the RF Survey. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Timeout ERROR.\nREBOOT 
MOBILE UNIT; 

Have been trying to contact the 
host for the radio timeout period (2 
minutes default). 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

REBOOT MOBILE UNIT; Reboot the Mobile Unit do to loss 
of connection. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Retry (Y/N)?; Try again. Try to send or receive again, or perhaps 
ensure that the printer is cabled to the 
Mobile Unit and is on. 
 

--- 
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TIMEOUT\n\nSending Data; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

TIMEOUT\n\nReceiving Data; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Host Received Data\nAwaiting App 
Reply!; 

Mobile Unit has sent and received 
an acknowledgement from the IP 
stack and is waiting for the 
application to return data. 

Most likely a host or network issue. 
Troubleshoot the customer’s environment. 
Probable causes are Database record 
locking, application program failure, Host 
failure or network failure. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

* WAITING TO SEND  *; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

TCP Error Reading\nMAC 
Address.\nREBOOT MOBILE UNIT; 

Could not obtain the Mac Address 
from the Mobile Unit. 

Possible hardware, driver or stack problem 
Contact the Mobile Unit manufacturer. 

--- 

Invalid TIP Command; Bad internal protocol. Notify Connect over the WEB incident 
reporting system. 

--- 

Session Ended\nBy User or Host; User, Host, application or network 
has ended the session. 

If the user did not end the session, most 
likely host or network issues. Troubleshoot 
the customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Server Packet Error; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
server operation. 

--- 
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Error receiving host\nlist from Server; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
server operation. 
 

--- 

Unexpected Server\ndata received; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
server operation. 
 

--- 

Error starting\nhost application; Connected to the server but can 
not connect to the distant end. 

Configure the server handler to access the 
host application. 

--- 

Select Host or App; Need to choose your 
Host/application destination. 

User selection required. --- 

Connecting...; Attempting to connect to the 
Host/application. 

Advisory message. --- 

TCP Error\nReading IP 
Address\nREBOOT MOBILE UNIT; 

Mobile Unit missing Network IP 
information. 

Configure the Mobile Unit with the correct 
network IP information. 

--- 

Printer start error; Could not initialize the printer. 
 
 

Cable or power issue with the printer. --- 

Battery too low\nto print; Not enough power to print. Replace the battery with a fully recharged 
battery. 
 

--- 

Paper Feed Error\nFix Then Hit Enter; Paper in the printer is not ready. Replace the paper or rethread the paper in 
the printer. 
 

--- 

Printer Error\nPrint Ended; Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 
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User Count Exceeded.\n Session 
Ended;  

Possible authorization issue. Verify that you have the correct number of 
licenses for the number of Mobile Units 
you are using. 
 

--- 

Primary Unavailable\nTrying Alternate; First Host IP address not available 
trying the remaining addresses in 
the Host list. 

Verify the host address. --- 

APMAC.DAT Error\nSession Ended; Access point Media Access Control 
error. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

MUIP.DAT Error\nSession Ended;  Mobile Unit IP Error. Most likely a Mobile Unit network setting 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Missing Subnet IP\nSession Ended;  Mobile Unit IP Netmask Error. Most likely a Mobile Unit network setting 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Error Opening File;  File is missing. Verify that the configuration files are on the 
Mobile Unit.  Or perhaps there is a 
hardware failure. 

--- 

Telnet API\nnot found; Program files are missing. Reload program files. --- 

Battery Low Warning\n\nReplace 
Battery Soon;  

Not enough power to operate the 
Mobile Unit. 

Replace the battery with a fully recharged 
battery. 

--- 

No Host List.\nPress any key\nTo Edit 
Host IP's;  

Have not configured your target 
hosts. 

Configure the target host IP addresses. --- 

Unable to Allocate\nFont Memory; Mobile Unit does not have enough 
memory to load the fonts. 

Reduce the fonts in use or expand the 
memory in the Mobile Unit. 
 

--- 
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Font Loading Error; Could not load the font. 
 
 

Ensure that the font is available to load. --- 

Printer Not Ready\nPress R to 
Retry\nC to Cancel Print; 

Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

Mobile Unit in\nDemonstration 
Mode\nfor TwinClient;  

Running in demo mode. Purchase a license from Connect. --- 

Connected to Host;  Successful connection to the target 
Host. 

Advisory message. --- 

Telnet Mode not\nsupported on\nthis 
Mobile Unit;  

This Mobile Unit must be used with 
a Connect Server. 

Order a Connect Server. --- 

Telnet Setup files\nnot found. 
Reload\nfiles then switch;  

Customer specific configuration 
files are missing. 

Load the configuration files into the Mobile 
Unit from Twin Client Manager. 

--- 

Switched Client to\nTelnet Direct Mode; Mobile Unit running in Telnet mode 
direct to the target Host. 
 

Advisory message. --- 

Switched Client to\nServer Based 
Mode;  

Mobile Unit running through a 
Connect server in Server mode 
usually at port 1800. 

Advisory message. --- 

Port 23 is only\nallowed in Telnet 
Mode;  

Can not set the port to 23 in Server 
mode.  Port 23 is the standard 
Telnet port. 

Advisory message. --- 

Not Enough Memory\nTo Run; Mobile Unit does not have the 
capacity to run the program do to 
memory restrictions. 

Expand the Mobile Unit memory. --- 

Press any key; Press a key to continue. Advisory message. --- 
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TwinClient Telnet;  Prompt. Advisory message. --- 

TwinClient Server;  Prompt. Advisory message. --- 

TwinClient TN3270; Prompt. Advisory message. --- 

TwinClient TN5250; Prompt. Advisory message. --- 

TwinClient TNVT; Prompt. Advisory message. --- 

(c) 1991-2006 Connect; Prompt. Advisory message. --- 

Edit Menu Options; Menu Title. Advisory message. --- 

Edit Mobile Unit IP; Menu Option. Advisory message. --- 

Edit Server/Host IPs; Menu Option. Advisory message. --- 

Edit Radio Option; Menu Option. Advisory message. --- 
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Edit License Key;  Menu Option. Advisory message. --- 

Run Site Survey;  Menu Option. Advisory message. --- 

Switch Client Modes; Menu Option. Advisory message. --- 

Run TwinClient; Menu Option. Advisory message. --- 

Exit to OS;  Menu Option. Advisory message. --- 

Printer may not be\nplugged in 
or\nturned on!; 

Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

OUT OF RANGE OF BASE; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

CONNECT SERIAL CABLE; Serial cable not connected to the 
Mobile Unit. 

Check cable, battery and communication 
settings for the Mobile Unit. 

--- 

REMOVE SERIAL CABLE; Remove serial cable from to the 
Mobile Unit. 

Check cable, battery and communication 
settings for the Mobile Unit. 

--- 

PLACE IN CRADLE; Place the Mobile Unit in the cradle. Advisory message. --- 
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REMOVE FROM CRADLE; Remove Mobile Unit from the 
cradle. 

Advisory message. --- 

ACQUIRING CRADLE BUS;  Attempting to access the cradle 
through the serial port you have 
configured. 

Advisory message. --- 

Printer Out\nOf Range; Printer out of the coverage area. Most likely a range, access point or radio 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Refused\nBy Host; You connected to the target host 
but the host disconnected you. 

Verify that the configuration file has the 
correct Mobile Unit type and New 
environment variable set.  Fallback to the 
Connect Default to verify the connection. 

--- 

Connection Timed Out; You connected to the host but did 
not logon in the appropriate time so 
the host disconnected you. 

Modify the Host parameters for login. --- 

Connection Failed\nHost Not 
Responding; 

Could not connect to the Host. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Failed\nHost Unreachable; Could not connect to the Host. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Out\nOf Range, 
Unable\nTo Transmit; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Out\nOf Range, 
Unable\nTo Receive; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

--- 
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Printer Not\nResponding; Can not print. Check cable, battery, communication 
settings and paper in the printer. 
 
 

--- 

Printer Out\nOf Range; Printer out of the coverage area. Most likely a range, access point or radio 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Print Complete; Prompt. Advisory message. --- 

Reprint (Y/N)?; Yes or No prompt for a reprint. Advisory message. --- 

WARNING;  Prompt. Advisory message. --- 

Turning power off\nduring a 
session\nwill cause the\nprogram to 
restart; 

This Mobile Unit will disconnect the 
session if powered off. 

Mobile Unit manufacturer limitation. 
Advisory message. 

--- 

Are you sure (y/n)?; Yes or No prompt for a 
confirmation. 

Advisory message. --- 

You Sure? (YyNn); Yes or No prompt for a 
confirmation. 

Advisory message. --- 

Domain Name Server\nNot Set; DOMAIN NAME SERVER not 
configured. 

Configure the Mobile Unit with the correct 
network IP information. 

--- 

Domain Name Server\nQuery Memory 
Error; 

Memory error on the Mobile Unit Expand the Mobile Unit memory or return 
the Mobile Unit for repair. 

--- 
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Domain Name Server\nQuery Sending 
Error; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Domain Name Server\nQuery Receive 
Error;  

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Domain Name Server\nUnavailable; Could not connect to the DOMAIN 
NAME SERVER. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Error loading\nparameter file; Could not load the parameter file. Reload the correct configuration files. --- 

Could not open\ntelnet interface; Could not Telnet. Reload the program files. --- 

Could not set\mtelnet options; Could not use the Telnet 
configuration. 

Reload the correct configuration files. --- 

Setup file\nsetting mismatch\nReload 
Setup; 

Emulation program selected is not 
compatible with the configuration 
file on the Mobile Unit. 

Remove the emulation and configuration 
files. Run clear Telnet on the Mobile Unit 
then reload the Mobile Unit with the proper 
emulation and configuration files. 

--- 

Display formatting\ntoo large 
for\ncurrent screen; 

Mobile Unit does not have enough 
memory to run your configured 
reformatted screens. 

Expand the Mobile Unit memory or order a 
server from Connect. 

--- 

Mobile Unit\ninitialization error; Mobile Unit problem. Return the Mobile Unit to the manufacturer 
for repair. 

--- 
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Host/App/Network\nclosed the session; Customer’s environment 
disconnected the Mobile Unit 
session. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Disconnecting...;   Prompt. Advisory message. --- 

Scan Barcode; Bar code scanning test. Advisory message. --- 

Enter Setup\nPassword;  Prompt. Advisory message. --- 

Enter Profile \nPassword; Prompt. Advisory message. --- 

Host IP; Host IP address prompt. Enter target host IP address. --- 

Host Name; Host name prompt. Enter target host Name. --- 

Port; Host IP port required. Enter 23 for Telnet or 1800 for a Connect 
server. Could also be a different number 
depending on the customer’s environment.

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Type;  Prompt. Advisory message. --- 

WARNING: This will \nend any\ncurrent 
session; 

Prompt. Advisory message. ---
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Continue (Y/N)?; Prompt. Advisory message. --- 

HOST ENTRY; Prompt. Advisory message. --- 

VT(100/220) Setup; Prompt. Advisory message. --- 

Mobile Unit Info; Prompt. Advisory message. --- 

Emulation Setup; Prompt. Advisory message. --- 

ANSI Setup; Prompt. Advisory message. --- 

Miscellaneous Setup; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 

Control Codes; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 
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<BK SP> Sends; Prompt. Advisory message. --- 

New Line Mode; Prompt. Advisory message. --- 

Insert Mode; Prompt. Advisory message. --- 

Autowrap Mode; Prompt. Advisory message. --- 

Cursor; Prompt. Advisory message. ---

EMULATION SETUP; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 

Map Underline; Prompt. Advisory message. --- 

Break Key; Prompt. Advisory message. --- 
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ANSI Setup; Prompt. Advisory message. --- 

Control Codes; Prompt. Advisory message. --- 

Backspace Key; Prompt. Advisory message. --- 

MISCELLANEOUS SETUP; Prompt. Advisory message. --- 

Test Options; Prompt. Advisory message. --- 

Login Options; Prompt. Advisory message. --- 

TEST OPTIONS; Prompt. Advisory message. --- 

Printer Test; Prompt. Advisory message. --- 

Scan Code Test; Prompt. Advisory message. --- 

LOGIN OPTIONS; Prompt. Advisory message. --- 
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User Name; Prompt. Advisory message. --- 

User Password;  Prompt. Advisory message. --- 

ON; Prompt. Advisory message. ---

OFF; Prompt. Advisory message. ---

Map; Prompt. Advisory message. ---

Don't Map; Prompt. Advisory message. --- 

Enable Break; Prompt. Advisory message. --- 

Disable Break; Prompt. Advisory message. --- 

7 bit; Prompt. Advisory message. --- 

8 bit; Prompt. Advisory message. --- 
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Send Delete; Prompt. Advisory message. --- 

Send Backspace;  Prompt. Advisory message. --- 

Mobile Unit Setup; Prompt. Advisory message. --- 

Scanner Options; Prompt. Advisory message. --- 

Program Options; Prompt. Advisory message. --- 

Special Options;  Prompt. Advisory message. --- 

Beeper Options;  Prompt. Advisory message. --- 

Exit to DOS; Prompt. Advisory message. --- 

Backlight Time; Prompt. Advisory message. --- 

Enter Key Action; Prompt. Advisory message. --- 
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Reset Options; Prompt. Advisory message. --- 

Font Size;  Prompt. Advisory message. --- 

Portable Printer; Prompt. Advisory message. --- 

Reprint Option; Prompt. Advisory message. --- 

Data IDs; Prompt. Advisory message. --- 

Internal/External; Prompt. Advisory message. ---

Modify Beeps; Prompt. Advisory message. --- 

Message Beeps;  Prompt. Advisory message. --- 

Scan Identifier; Prompt. Advisory message. --- 

AID Scan Setup; Prompt. Advisory message. --- 
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Long Scans; Prompt. Advisory message. --- 

Scan Send;  Prompt. Advisory message. --- 

Yes; Prompt. Advisory message. ---

No;  Prompt. Advisory message. --- 

Normal; Prompt. Advisory message. ---

Double Wide; Prompt. Advisory message. --- 

Double High; Prompt. Advisory message. --- 

Double High and Wide; Prompt. Advisory message. --- 

Errors Only; Prompt. Advisory message. --- 

Automatic; Prompt. Advisory message. ---
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All Messages;  Prompt. Advisory message. --- 

Reject; Prompt. Advisory message. ---

Truncate; Prompt. Advisory message. ---

Split;  Prompt. Advisory message. --- 

Do Not Send; Prompt. Advisory message. --- 

Always Send; Prompt. Advisory message. --- 

Last Field Only; Prompt. Advisory message. --- 

Internal; Prompt. Advisory message. ---

External; Prompt. Advisory message. ---

none; Prompt. Advisory message. ---

Supported Equipment Manual   •   May, 2006    4-21



Error Message Resolution Guide 

 

Message Reason Solution Reference Tech Note 
    

     

     

     

     

     

     

monarch; Prompt. Advisory message. ---

pddumb; Prompt. Advisory message. ---

comtec; Prompt. Advisory message. ---

rascal; Prompt. Advisory message. ---

codewriter; Prompt. Advisory message. ---

comtec(S); Prompt. Advisory message. ---

User Name; Prompt. Advisory message. --- 

Password;  Prompt. Advisory message. --- 

Frequency:      Hz; Prompt. Advisory message. --- 

Duration:       ms; Prompt. Advisory message. --- 
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Delay:          ms;  Prompt. Advisory message. --- 

Select Scanner; Prompt. Advisory message. --- 

Setup Scanner; Prompt. Advisory message. --- 

Scan Test; Prompt. Advisory message. --- 

Scan Operation;  Prompt. Advisory message. --- 

Laser; Prompt. Advisory message. ---

Contact/Pulse; Prompt. Advisory message. ---

Contact/No Pulse; Prompt. Advisory message. --- 

Auto/Pulse; Prompt. Advisory message. ---

Auto/No Pulse; Prompt. Advisory message. --- 
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Wand Simulation;  Prompt. Advisory message. --- 

VT100; Prompt. Advisory message. ---

VT220; Prompt. Advisory message. ---

SETUP; Prompt. Advisory message. ---

Mobile Unit IP/Radio; Prompt. Advisory message. --- 

Host List; Prompt. Advisory message. --- 

NULL; Prompt. Advisory message. ---
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